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Photoshop Session 1 
 

This session will cover only “global” changes to images.  That is, changes to the whole image 
and not just a part of it.  Session 2 will get us into changing one part of an image without 
changing the whole thing. 
 
This time we will concentrate on a few tools and only some of the items that appear in the 
window when you open Photoshop.  The first challenge is to figure out how to get an image file 
loaded and the image visible on the screen.  We use the File Browser to do this.  Once the image 
is on the screen we can evaluate what needs to be done to the entire image to improve it in some 
way.  Not every image needs to be changed by Photoshop.   
 
Menu Items used for first lesson: 
 
File 
   Save As 
 
Edit 
   Transform 
        Rotate 
        Distort 
        Perspective 
        Skew 
 
Image 
   Image Size 
   Reveal All 
 
Layer 
   Duplicate Layer 
   New Adjustment Layer 
         Levels 
         Color Balance 
         Hue/Saturation 
   Flatten Image 
 
Filter 
   Sharpen 
         Unsharp Mask 
 
View 
   Fit On Screen 
   Actual Pixels 
 
 
 
 

Layers 
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We will emphasize non-destructive image editing.  That is, the image will be changed in such a 
way that you can always undo a correction or change the settings for a correction that has been 
made.  The advantage of this of course is that as you make further modifications in an image you 
might want to go back and change a previous adjustment. 

 
For this reason we will start using Layers immediately.    If you load an image, say a .jpg, and 
make corrections without using layers, you modify the values for each pixel in the file.  If you 
change your mind later and make a further change, you lose some of the original information 
because you have applied two corrections in succession.  (It is the problem of so called rounding 
errors in mathematics.  Repeated operations allow errors to accumulate).  The reason to use a 
layer is simple.  First of all, think of a layer as a large spread sheet.  On the sheet there is a box 
for each pixel of the image.  That box contains the information that tells Photoshop what to do to 
that pixel to bring about the correction.  When you look at the image in Photoshop, those 
corrections are applied to the original values, BUT the original values are left unchanged.  Each 
Layer contains another spreadsheet giving instructions on how to manipulate each pixel of the 
image after it has been manipulated by the previous layer’s instructions.  Some of the layers’ 
instructions may be very simple, the same “formula” being applied to each pixel, such as for 
example, “Multiply the red value in each pixel byt 0.8” to shift the color balance away from red.  
Others might possibly have a different instruction for each pixel in the image.  The image that 
you see on the screen is the original image with all of the successive layer corrections applied to 
it. 
 
Because the corrections done by a layer don’t change the original value, you can always go back 
and adjust the corrections in any layer and not ever lose any information, nor ever modify the 
information in the original image.  When you are done correcting an image you can save the 
image with all the layers still separate, as a PSD file.  PSD files are BIG but if you think you 
might ever change your mind concerning any correction you have made, you can reload the PSD 
file and continue where you were when you saved the file. You can even delete a layer and it’s 
corrections if you decide to do something different or if you think there might be a better way to 
correct the image.  It is important not to save the file as a .jpg file again without renaming it, or 
you will overwrite your input file, assuming the original was a jpg.  
 
 
 
 

Adjustment Layers 
 

We will limit ourselves initially to just a few types of adjustments, those most commonly used, 
and discuss how to do them and what order is best. 
 
In the upper right hand corner of the Photoshop work area is a histogram.  The histogram is 
nothing more than a bar graph.  The overall histogram shows how many pixels are at each of the 
255 brightness levels in an image.  At the left is black, brightness 0.  At the right is White, 
brightness 255.  In the middle is brightness 128, a medium gray. 
 
If your image contains no blacks, the values at the left end of the histogram will be zero or very 
small.  If it contains no whites, the values at the right end of the histogram will be zero or very 
small.   
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Usually a well exposed image will be lacking in blacks or whites, or both.  Our first Adjustment 
tool is called Levels, and it will be used to improve the tonal range of an image.  MOST images 
benefit from containing brightness (or Luminosity) values from 0 to 255.  The image has good 
contrast when this situation exists.  You may not want to include the darker tones in, say, a 
picture taken in a fog or haze.  However, for now we will concentrate on stretching the tonal 
range of an image to fill the histogram or nearly so.  There is no “standard” look to a histogram.  
The shape of the curve is very dependent on the subject. 
 
The histogram can tell you if your image is overexposed.  If there is a large value (called a spike) 
at the extreme right end of the histogram, some of the highlights are pure white or “blown out”.  
If there is a large value at the extreme left of the histogram, your image is underexposed and a lot 
of pixels are pure black. 
 

Levels 
 
We get the menu for adjustment layers and choose Levels.  We get a box asking us if the name 
“Levels 1” is OK.  Usually the default names are fine and I wish fervently that there would be 
some way to turn off the name window and save a mouse click every time you use the tool.  OK 
so we say OK to the name and we get a window that looks like a copy of the Histogram that is 
already on the screen.  However in this window we can do something about the histogram 
besides looking at it.  Below the histogram diagram are three little triangles.  Let’s say the 
brightest pixels in your image are only at value 210.  You grab the right hand triangle with the 
mouse and drag it to the left to the 210 value and magically the histogram is stretched out so that 
the 210 value becomes 255 and all the other values are pulled up accordingly.  At the left end of 
the diagram is a black triangle.  Suppose the darkest value in the histogram is 46.  You slide the 
black triangle up until it is at 46 (value appears in a little box on the diagram) and the bottom of 
the histogram is stretced so the darkest value is 0 or nearly so.  In the process of spreading the 
brightness values sometimes there are some levels that go to zero so you have “slots” in the 
histogram.  If there are too many of them, the image may show visible edges where one level 
changes to another.  This is called “Banding” because you see intensity bands in the image.  This 
indicates that you have stretched things too far!  This is a good reason for shooting in Raw mode, 
but that’s another story for another time! 
 
Now comes the real fun.  Image look too dark?  Grab the middle triangle and drag it to the left.  
The image becomes brighter in the mid tones but black and white don’t change a bit.  Image too 
light?  Drag the middle triangle to the right to darken the mid tones. 
 
When you are happy with the tonal range and brightness of the image, click OK in the Levels 
box and it will close.  On the lower right of the screen you will see a “pile” of layers.  At the 
bottom is your original image, called the background layer.  On top of that is the Levels 
adjustment layer.  At the left of that icon is an eye.  Want to see what the image looked like 
before your adjustments?  Click on the eye and it will disappear.  The layer will be shut off.  
Click again and the eye returns.  Neat, Huh? 
 

Hue/Saturation 
 

Now let’s make another layer, a Hue Saturation layer.  Go to the layers menu, move down to 
Adjustment Layer and over to Hue/Saturation.  Click that and go through the layer naming 
process again, i.e. click OK.  Now you will have a box with three sliders.  Grab the Saturation 
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slider with the mouse and drag it all the way to the left.  Voila! You have a black and white 
image.  This is the simplest way to get one from a color image, though far from the best way.  
We’ll cover that another time. 
 
Now drag the slider all the way to the right.  See the totally exaggerated colors!  Might make an 
interesting poster.  OK so we don’t want black and white, and we don’t want a poster.  Just move 
the pointer to a more reasonable setting.  If the original image was a bit drab, increase the 
saturation.  If increasing the contrast in the Levels adjustment made the color too bright (it does 
sometimes) reduce the saturation.  Note now you have a third layer in the pile.  There are two 
other sliders in the Saturation adjustment window.  One says LIGHTNESS.  Don’t use it.  We’ve 
already looked at the better way to adjust the lightness of the image with the Levels controls.  
The third slider is a HUE adjustment.  It rotates all the colors through the standard color circle.  
It very seldom does anything useful to an image unless you want to do something strange!  When 
you are satisfied with your Saturation adjustments, click OK.   
 

Color Balance 
 
Now select the layer menu again and an adjustment layer.  Select Color Balance.  Same old 
window wanting to know if you want to give the layer a name.  The default one is usually OK at 
least at this point in our exploration of Photoshop.  This tool also has three sliders.  There is one 
for each of the three “primary colors” and their opposites.  One controls RED/CYAN, one 
BLUE/YELLOW and the third GREEN/MAGENTA.  You can think of the second colors in the 
above as negative.  That is, Cyan is minus RED.  If the image is not red enough, you move that 
slider toward red.  If it is too red you move the slider in the Cyan direction.    Another way of 
looking at the secondary or negative colors is that each is a mix of two of the primary ones: 
 
Cyan = minus Red = Blue plus Green 
Magenta = minus Green = Red plus Blue 
Yellow = minus Blue = Red plus Green 
 
The primary colors are called additive colors.  If you project light through three filters, Red, Blue 
and Green and overlap the images (and balance the intensities correctly) the place where all three 
overlap will be white.  The places where two overlap will show cyan, magenta and yellow. 
 
The secondary colors are the subtractive colors.  They are used for inks (and in your printer)  
Cyan plus Magenta plus Yellow =  Black.  Printing inks are not perfect, so most printers use 
black too, four colors, Cyan, Magenta, Yellow and Black or CMYK for short.  For photographic 
printing, because of the limitations of the printer the better ones all add light Magenta and light 
Cyan.  These boast 6 color printing.  The printer is limited in the minimum size dot that it can put 
on the paper, so the diluted colors are used when a very small dot is needed. 
Well, so much for color theory.  Now with the sliders in the Color Balance tool you can fix the 
color balance of your image.  Suppose you took a shot on an overcast day but you would like to 
make it look more like a sunny day.  Increase the Yellow by dragging the appropriate slider.  Try 
a value of 20.  Now increase the Red by about half as much.  At this point I might say to “season 
to taste” with regard to color balance.  When you have what you like, click OK and notice that 
you now have four layers showing.  You can turn any one or all of them off by clicking on the 
Eye image.  Sometimes a later change makes it necessary to change an earlier setting.  Just click 
on the icon and the adjustment window opens again for you to readjust things.  You might notice 
that there are three boxes or buttons in the window that indicate Shadow, mid tones or 
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Highlights.  Normally the mid-tones box is selected.  If you want to change a color tinge in the 
highlights only, you can select highlights, same for shadows.  My observation is that the 
corrections are not very well limited to highlights or shadows if you make those selections, but 
they do have some effect. 
 

Saving your image 
 

Now your image looks like what you want.  What do we do next?  Save it of course, but we do 
NOT save it back to the original file name.  It is advisable if you have the space on your hard 
drive or have a CD burner, to save the image as it is now with all the separate layers.  Click Save 
As.  From the file type choices select PSD. And click Save.  It’s done.  You can of course save it 
in a different folder because Save As gives you the opportunity to select a different path for the 
file.   
 
Now if you ever want to change your interpretation of the image you can load the PSD file and 
you will be right back where you left off. 
 

Printing your Image 
 

Ok so now what?  Let’s make a 5 by 7 print.  Over on the left is the tool bar.  Click on the icon 
that looks like a pair of carpenter’s squares.  Now at the top of the screen three boxes open.  In 
the leftmost one labeled Width, type 7 and move over to the second with your mouse.  It is 
labeled Height.  Type in 5.  Move to the third box and type in the dots per inch for the image.  
For a small print like this, most cameras produce enough resolution so that you can use 300 for 
that value.  Now put the cursor in the upper left hand corner of your image and drag down and to 
the right.  You will see an outline of the area to be kept when it is cropped.  The rectangle 
maintains the proportions of 5 to 7.  If you make it longer it automatially becomes wider.  Of 
course the image won’t fit that frame.  If you have an SLR the image will fit 5 by 7.5.  If you 
have a point and shoot with a 3 to 4 image ratio, it will fit 5 by 6.67 inches.  You can crop to an 
odd size or you can crop away some of your image to fit the format of the paper.  After you drag 
the lower right hand corner down you can release the mouse button.  Now you can drag the 
whole crop area in any direction, being careful not to drag an edge past the edge of the image. 
You don’t have to use the whole width or height of the image.  You can crop a fraction of the 
image.  You can drag the corners of the crop area until you are happy with the image.  Now 
RIGHT click inside the image and left click on CROP and the job will be done. 
 
I must emphasize that you have not only cropped your image but you have resized it.  You can 
crop an image without resizing it.  I frequently do that just to get a nice composition from my 
initial image.  Select the cropping tool again.  In the so called options bar you will see your 5 by 
7 by 300 DPI that we have just set up.  Click on the CLEAR button and those dimensions will all 
go away.  Now you have a free form crop tool.  You can crop the image any way you like, 
square, long narrrow or whatever.  The resolution will not change when you crop in this manner. 
 
------------------------------------------------- 
Resizing seems to be the bane of any discussion about digital images.  It is not, or should not be 
so mysterious.  Suppose you have a 1 megapixel camera that takes a square image, 1000 by 1000 
pixels (1000 times 1000 = 1,000,000 or one megapixel).  Now you want to make a 6 2/3 inch 
square print.  How many pixels per inch would you get if you didn’t resize the image?  1000/6.67 
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= 150 pixels per inch, but if you print at that resolution the resulting print will show stairsteps in 
diagonal lines.  So, we let Photoshop add pixels. 
 
Since Photoshop has no information from which to add pixels, it “interpolates”.  In our present 
case we need to double the number of pixels in each direction, i.e. make a 2000 by 2000 image.  
That means that Photoshop will generate a new pixel half way between each pair of pixels.  The 
simplest way would be to average the values.  Left pixel has a value of 100, right pixel has a 
value of 150, add a pixel between with a luminosity of 125 etc.  Photoshop uses a better 
calculation than just the average for conditions where the numbers don’t come out as even as in 
this example. 
 
Ok so we resize our image to 2000 by 2000 and print it 6.67 inches square and have 300 pixels 
per inch on the print.  Just what we wanted.  The complication is that if you make a number of 
different sized prints, you need to resize the image for each one to get optimum print quality.  
Obviously resizing can degrade the image so you don’t want to resize the same image serially 
but always start with the PSD file you saved away. 
-------------------------------------------------------- 
 
Next step is to FLATTEN the image.  Go to the Layers Menu and at the bottom is the item 
Flatten Image.  Click on that and all the layers will be combined into one.  This cannot be 
reversed!!  You still have the PSD image that you just saved on your disk however.  Now with 
the image flattened, select the Filter Menu and select Sharpen.  Select “Unsharp Mask”.  In the 
window that opens, set the Levels slider to 1.  Set the Radius slider to 1.3.  Check the preview 
box.  Now put the little box that becomes the cursor at a point of interest in the image and click.  
The preview box shows that area of the print.  Now move the Amount slider up all the way.  You 
will see the effect of very much oversharpening.  Back off until the preview box looks 
reasonable.  The preiew box shows actual pixels and is a good way to decide whether the image 
is over sharpened or not.  I’ve used values from 50 up to 250 with these settings.  When you are 
happy with the results click OK.  These values are just starting points.  Increasing the Levels 
slider reduces the sharpening and eliminates adding noise to things like blue skies.  Increasing 
the Radius increases the sharpening.   
 
Now you have a file ready to make a 5 by 7 print.  Time to save it in yet another form.  Click 
Save As and choose TIF or TIFF file type.  Now when I size and sharpen an image for a 
particular size print, I rename the file.  You can use the original name assigned by the camera, 
but edit it to add “7_5” for a horizontal print or 5_7 for a vertical. 
 
For example:  IMG4567 7_5.TIF 
 
Now save the file and you are ready to make a 5 by 7 print anytime you want one.  If you want to 
make, say an 8 by 10, go back to the PDF file, and crop to 10 by 8 by 240 pixels per inch.  Then 
flatten the image (you can flatten it first if you like), and go through the sharpening process with 
this newly scaled image.  Save it with 10_8 or 8_10 added to the filename.  For larger images I 
use 240 pixels per inch because we look at larger prints from farther away.  240 is a good value 
for the printer, and having a bit less resolution in the print does less damage to the image than 
increasing the image size too much by adding too many pixels. 
 

 
Straightening an Image 
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Lastly we can do a couple of other things to a whole image, that is a Global change.  Suppose 
you have a nice landscape but the horizon is crooked.  I have plenty examples. 
 
Get the file loaded and select “Fit image on screen” from the View menu.  Now from the view 
menu select zoom out.  Your image will have a gray area around it.  In the Layer menu select 
Duplicate Layer and accept the default name “Background copy”.  You won’t see any difference.  
Photoshop won’t let you rotate the original background image but you can do what you like with 
the copy.  Go to the Edit Menu and select Transform.  A sub menu gives you several choices.  
Choose Rotate, the one high up in the menu.  Now when you put your cursor in the image you 
will see a curved line with an arrow at each end.  Position the cursor near a corner of the image 
and move it in one direction or the other and the image will rotate.  You can eyeball a level 
horizon or you can drag a guide line down from the ruler at the top of the window.  When you 
have the image level hit ENTER on the keyboard and wait a moment until the frame goes away.  
Now it might look like the image still fills the area but it does not.  Click on the Eye icon for the 
background layer and you will see that parts of the image are missing.  Select the crop tool and 
click on the CLEAR button to the right of the Resolution box.  This makes the crop free form as 
discussed previously.  Carefully mark the biggest rectangle you can inside of the real image, 
excluding the corners that are empty and select CROP after a right click.  now you have 
straightened your image. 
 

Perspective Correction 
 
Now suppose you have a building in your photo.  You’ve pointed the camera up at it so 
perspective seems to make it get smaller at the top.  This is particularly apparent in pictures of a 
building. 
 
Select the Edit Menu, Transform, and Perspective.  Now drag one of the top corners outward.  
The other will mirror the action.  At some point the perspective will be such that the sides of the 
building are parallel and straight.  ENTER again and the image will be corrected. Since you’ve 
made the top of the building wider, it might look a bit squat. 
 
Edit Menu, Transform, Distort.  Now drag the top of the image up until the building looks 
normal.  You might first go to the Image menu and select “Reveal All” so you can see the 
keystoned image shape and also the top of the image as you drag it up.  Now you will have to 
crop again to get back to a rectangular image. 
 
There is one other useful transform correction, called SKEW.  With it you can make a different 
perspective correction on each side of the image.  You can pull the corner of the image by 
dragging it, and only that corner will move.  With the PERSPECTIVE tool if you drag the upper 
right hand corner to the right, the left corner moves to the left by the same amount automatically. 
 
REMEMBER that the Transform and Rotate functions only work on a COPY of the background 
image.   Now you can save the image as a PDF or continue to make other corrections on it. 
 
This ought to be more than enough for one session!  Practice all of this on some of your images.  
Get comfortable with Layers and saving PDF and TIFF files.  To summarize our use of files, we 
started with a .jpg file, the original image.  We made corrections to the image using layers, and 
saved the file with the corrections as a .PSD file.  Then we flattened the image, chose a print 



 - 8 - 

size, cropped and resized the image to fit the print size, sharpened it and saved it with a tag to the 
filename indicating the size of the  print for that TIF  image file.  That is it unless you have 
started with a RAW file, in which case you will not have the .JPG file, but a RAW instead. 
 
Next time we’ll look at changes to PARTS of an image rather than the whole image. 


